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6 Important Notes

1.1
1.1.1

1.1.2

Important Notes

This section provides a summary of the most important safety requirements and
notes which are also mentioned in the individual sections. To protect your health
and prevent damage to the devices, it is essential to read and carefully follow the
safety guidelines.

Legal Principles
Copyright

This manual including all figures and illustrations contained therein is subject to
copyright. Any use of this manual which infringes the copyright provisions
stipulated herein, is not permitted. Reproduction, translation and electronic and
phototechnical archiving and amendments require the written consent of WAGO
Kontakttechnik GmbH & Co. KG, Minden. Non-compliance shall attract claim
for damages.

WAGO Kontakttechnik GmbH & Co. KG reserves the right to enact changes that
serve technical progress.

All rights arising from the issue of a patent, or the legal protection of utility
patents, are reserved to WAGO Kontakttechnik GmbH & Co. KG. Third-party
products are always indicated without any notes concerning patent rights. Thus,
the existence of such rights must not be excluded.

Personnel Qualification

The use of the product described in this manual requires special qualifications, as
shown in the following table:

Table 1: Personnel Qualification

Activity Electrical specialist

Assembly

Commissioning

Programming

Maintenance

Troubleshooting

oo A A R A

Disassembly

All personnel must be familiar with the applicable standards.

WAGO Kontakttechnik GmbH & Co. KG declines any liability resulting from
improper action and damage to WAGO products and third-party products due to
non-observance of the information contained in this manual.

waco'
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11.3 Proper Use of the TO-PASS® Telecontrol Modules

The TO-PASS" telecontrol modules receive digital and analog signals from
sensors and transmit and output them to higher-ranking controllers. Additionally,
it is possible to (pre-)process them.

The device is designed for the IP20 protection class. It is protected against the
insertion of solid items (e.g, fingers) and solid impurities up to 12.5mm in
diameter, but not against water penetration. Unless otherwise specified, the device
must not be operated in wet and dusty environments.

1.1.4 Technical Condition of the Devices

For each individual application, the components are supplied from the factory
with a dedicated hardware and software configuration. Changes in hardware,
software and firmware are only admitted within the framework of the possibilities
documented in the manuals. All changes to the hardware and/or software and the
non-conforming use of the components entail the exclusion of liability on the part
of WAGO Kontakttechnik GmbH & Co. KG.

Please direct any requirements pertaining to a modified and/or new hardware or
software configuration directly to WAGO Kontakttechnik GmbH & Co. KG.

WAGO TO-PASS® o
Telecontrol Modules M 761-20x wWAGD



8 Important Notes

1.2

Standards and Regulations for Operating the TO-
PASS® Telecontrol Modules

Please observe the standards and regulations that are relevant to installation:

The data and power lines must be connected and installed in compliance
with the standards to avoid failures on your installation and eliminate any
danger to personnel.

For installation, startup, maintenance and repair, please observe the accident
prevention regulations of your machine (e.g., BGV A 3, "Electrical
Installations and Equipment").

Emergency stop functions and equipment must not be deactivated or
otherwise made ineffective. See relevant standards (e.g., DIN EN 418).

Your installation must be equipped in accordance to the EMC guidelines so
electromagnetic interferences can be eliminated.

Please observe the safety measures against electrostatic discharge according
to DIN EN 61340-5-1/-3. When handling the modules, ensure that
environmental factors (persons, workplace and packing) are well grounded.

The relevant valid and applicable standards and guidelines regarding the
installation of switch cabinets must be observed.

waco'
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1.3 Symbols

A DANGER

Warning of physical injury
Indicates a direct hazard with a high level of risk, which may lead to death or
severe physical injury if it is not avoided.

A DANGER
Warning of physical injury due to electric current
Indicates a direct hazard with a high level of risk, which may lead to death or

severe physical injury if it is not avoided.

Warning of physical injury
Indicates possible hazard with a moderate level of risk, which may lead to death
or (severe) physical injury if it is not avoided.

A CAUTION

Warning of physical injury
Indicates possible hazards with a low level of risk, which will lead to minor or
moderate physical injuries if it is not avoided.

NOTICE

Warning of damage to equipment
Indicates possible hazard that could lead to equipment damage if it is not avoided.

NOTICE

Warning of damage to equipment by electrostatic discharge
Indicates possible hazard that could lead to equipment damage if it is not avoided.

NOTE: Please note
Indicates possible malfunction, which does not lead to equipment damage if
it is not avoided.

Information Notes on additional information
Indicates other informations, which are not an integral part of this
documentation, such as Internet.

WAGO TO-PASS® o
Telecontrol Modules M 761-20x wAaGo
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1.4

Safety Information

A DANGER

Warning of physical injury

TO-PASS" telecontrol modules are exposed operating equipment. They may only
be assembled in housings, cabinets or in electrical operation rooms. Access is
only permitted via a key or tool to authorized qualified personnel.

A DANGER

Warning of physical injury
All power sources to the device must always be switched off before performing
any installation, repair or maintenance work.

NOTICE

Warning of damage to equipment

The components are not resistant against materials having seeping and insulating
properties such as: aerosols, silicones, triglycerides (found in some hand creams).
If it cannot be determined that these materials appear in the component
environment, then the components must be installed in an enclosure that is
resistant against the above mentioned materials. Clean tools and materials are
generally required to operate the device/module.

NOTICE

Warning of damage to equipment
Soiled contacts must be cleaned using oil-free compressed air or with ethyl
alcohol and leather cloths.

NOTICE

Warning of damage to equipment
Do not use contact sprays, which could possibly impair contact area functionality.

NOTICE

Warning of damage to equipment
Avoid reverse polarity of data and power lines as this may damage the devices.

NOTICE

Warning of damage to equipment by electrostatic discharge
The devices are equipped with electronic components that may be destroyed by
electrostatic discharge when touched.

waco'
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1.5

1.6

Font Conventions

Table 2: Font Conventions

Font typ:e |Indicates:

italic Names of paths and files are displayed in italics, e.g.:
C:\Programme\WAGO-IO-CHECK

Menu Menu options are displayed in bold, e.g.:
Save

> A greater-than sign between two names means the selection of a
menu option from a menu. e.g.:
File > New

Input Designation of input or optional fields are displayed in bold, e.g.:
Start of measurement range

“Value” Input or selective values are displayed in inverted commas, e.g.:
Enter the value “4 mA” under Start of measurement range.

[Button] | Button names in dialog boxes are displayed in bold in square
brackets, e.g.:
[Input]

[Key] Names of keys on the keyboard are displayed in bold in square

brackets, e.g.:
[F3]

Number Notation

Table 3: Number Notation

Number code: | Example: Note:
Decimal 100 Normal notation
Binary '100' Within ',
'0110.0100' Nibble separated with dots

WAGO TO-PASS®

Telecontrol Modules M 761-20x

wAacGo'




12 Use

2 Use

The TO-PASS® product family is designed for wireless communication of signals
and messages.

This includes:

. compact module for the connection of signals from plants
. transmission
. preparation of values for the operator.

The system is connected in wireless mode to PCs, hand computers, Internet PCs,
web servers, mobile telephones, fax, e-mail receivers or land-line telephones.
Influences to the system are also possible.

Communication occurs using the global mobile radio network “GSM” (Global
System for Mobile Communication). A SIM card is required for the 7O-PASS®
telecontrol module to use this network. As in the case of a mobile telephone, the
TO-PASS® telecontrol module requires the SIM card in order to be able to “log
on” to the network.

No other components are required, other than the SIM card to connect to the GSM
mobile radio network and a GSM antenna (available as an accessory). Modems
and interfaces are already installed in the TO-PASS® telecontrol module.

TO-PASS® telecontrol modules may be used as:

. permanent on-line link

. fault indicator

. remote data request system
. data memory

. telecontrol modules.

In doing so, the modules of the WAGO TO-PASS" are classified as follows:

. WAGO TO-PASS® S - “S” = small, compact module
. WAGO TO-PASS® M - “M” = medium, universal compact module.

0 WAGO TO-PASS®
W}lﬂﬂ Telecontrol Modules M 761-20x
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3 Products

Table 4: Products

Item number Name
761-200 Telecontrol Module M,

8 digital inputs, 4 digital outputs
761-201 Telecontrol Module M 8AI,

8 digital inputs, 4 digital outputs,
8 analog inputs, 2 analog outputs

761-202 Telecontrol module M 8AI ESP,
8 digital inputs, 4 digital outputs,
8 analog inputs, 2 analog outputs,
event memory

761-203 Telecontrol module M 8AI DSP,
8 digital inputs, 4 digital outputs,
8 analog inputs, 2 analog outputs,
data memory

761-204 Telecontrol Module M S8AI ESP, DSP,
8 digital inputs, 4 digital outputs,

8 analog inputs, 2 analog outputs,

event memory, data memory

761-205 Telecontrol Module M WEB MODBUS,
8 digital inputs, 4 digital outputs,
Internet access via GPRS, Modbus

761-206 Telecontrol Module M 8AI WEB MODBUS,
8 digital inputs, 4 digital outputs,

8 analog inputs, 2 analog outputs,

Internet access via GPRS, Modbus

4 Scope of Delivery

The scope of delivery of the TO-PASS™ M telecontrol module, without options,
includes only the TO-PASS™ M telecontrol module. Suitable antennas are
available as accessories.

NOTE: SIM Card
Please note that one SIM card is required to operate each TO-PASS® M
telecontrol module and may be obtained from typical service providers such as
T-Mobile, VODAFONE or EPlus. WAGO Kontakttechnik GmbH & Co. K.G.
is prepared to assist with the selection of the most cost-effective tariff for your
application.

WAGO TO-PASS® o
Telecontrol Modules M 761-20x wWAGD
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5 View
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Figure 1: Front view
Position | Description
1 Antenna connection
2 SIM Card insert
3 Status indication
4 PC Interface
5 Connecting terminals for the supply, inputs and outputs

0 WAGO TO-PASS®
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6 Installing the Operator Software

1. Insert the CD with the TO-PASS" operator software in the CD ROM drive
of the PC

2. Close all applications allowing the Operating System to display the
Desktop.

3. Move the mouse cursor to the “Start” button of the Windows Operating
System and click on the right mouse button.

4.  Select Windows “Explorer” using a double click.
5. Select the CD ROM drive where the operator software will be inserted.

6.  Select the main directory of the CD and start the program “WAGO-TO-
PASS SETUP(x.yy).EXE”.

7.  Follow the menu guide to choose a default installation path.

8.  The installation is complete when the message “The software has been
installed successfully” is displayed.

WAGO TO-PASS® o
Telecontrol Modules M 761-20x wWAGD
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7 Assembly

71 Installation

1.  The TO-PASS® M telecontrol module is designed to mount on a DIN 35
carrier rail.

2. The protection class of the TO-PASS® M telecontrol module is IP 20.
This is why it is recommended that the module is mounted in a housing or a
in a switching cabinet.

3. The TO-PASS® M telecontrol module is designed for an ambient operating
temperature range of -20 °C to +70 °C.
In the event of higher or lower temperatures, proper cooling or heating
arrangements must be provided.
Please contact WAGO Kontaktechnik GmbH & Co. K.G. for assistance.

0 WAGO TO-PASS®
W}lﬂﬂ Telecontrol Modules M 761-20x
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7.2 Terminal Assignment

After installation, connect the wires depending on their use, according to the
following connecting diagrams:

7.21 Operating Voltage

Table 5: Terminal assignment for operating voltage

3

4
GND

Figure 2: Terminal assignment for operating voltage

Connection |Short name Designation

1 Uv Operating voltage (+) 8 to 36 VDC

2 Uv Operating voltage (+) 8 to 36 VDC
(parallel to terminal 1)

3 GND Operating voltage (-) "Ground"

4 GND Operating voltage (-) "Ground"
(parallel to terminal 3)

38 Shield Enclosure screening, connection of the PE

7.2.2 Digital Inputs

Table 6: Terminal assignment for digital inputs

5|79 11
DI1 | DI3 | DI5 | DI7

6|8 1012
DI2 | DI4 | DI6 | DI8

Figure 3: Terminal assignment for digital inputs

Connection |Short name Designation

5 DI 1 Digital input 1
6 DI2 Digital input 2
7 DI 3 Digital input 3
8 DI 4 Digital input 4
9 DI 5 Digital input 5
10 DI 6 Digital input 6
11 DI 7 Digital input 7
12 DI 8 Digital input 8

WAGO TO-PASS®
Telecontrol Modules M 761-20x wAaGo
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7.2.3

7.2.4

Analog Inputs

Table 7: Terminal assignment for analog inputs

131151171921 23|25 |27
A1 | AI2 | AI3 | Al4 | AI5 | AIE | AI7 | AI8
14116182022 24|26 |28
A1 | AI2 | AI3 | Al4 | AI5 | A6 | AI7 | AI8

Figure 4: Terminal assignment for analog inputs

Connection |Short name Designation

13 All+ Analog input 1 (+)

14 All- Analog input 1 (-)

15 Al2+ Analog input 2 (+)

16 Al2- Analog input 2 (-)

17 Al3+ Analog input 3 (+)

18 Al3- Analog input 3 (-)

19 Al4+ Analog input 4 (+)

20 Al4- Analog input 4 (-)

21 AlS5+ Analog input 5 (+)

22 AlS5- Analog input 5 (-)

23 Al6+ Analog input 6 (+)

24 Al6- Analog input 6 (-)

25 Al7+ Analog input 7 (+)

26 Al7- Analog input 7 (-)

27 Al8+ Analog input 8 (+)

28 AlS- Analog input 8 (-)

Digital Outputs

Table 8: Terminal assignment for digital outputs

Figure 5: Terminal assignment for digital outputs

33|35
DO1|DO3| DO

34|36
DO2|DO4

Connection |Short name Designation

33 DO 1 Digital output 1

34 DO 2 Digital output 2

35 DO 3 Digital output 3

36 DO 4 Digital output 4

37 DO Vce (+) Voltage for the digital outputs

waco'
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7.2.5 Analog Outputs

Table 9: Terminal assignment for analog outputs

31
AO2

32
AO2

Figure 6: Terminal assignment for analog outputs

Connection |Short name Designation

29 AO1+ Analog output 1 (+)
30 AOl- Analog output 1 (-)
31 AO2+ Analog output 2 (+)
32 AO2- Analog output 2 (-)

7.2.6 Antenna

The screw connector (FME plug) for the GSM antenna is located at the top of the

housing.

Figure 7: Antenna connection

WAGO TO-PASS®

Telecontrol Modules M 761-20x
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7.2.7  Serial interface to the PC
Table 10: PC Interface
( R Pin: Description
5 4 3 2 1
@ @ 1 Not assigned
2
9 8 7 6
3
4 Not assigned
5
6 Not assigned
L PC ) 7 Not assigned
Figure 8: 8 Not assigned
PC Interface 9 Not assigned
Table 11: Interface cable allocation
WAGO TO-PASS
Pin | Description Pin | Description
2 |RXD <> 2
3 |TXD <> 3
5 |GND <> 5
NOTE: Connecting laptops and PCs without serial interface:

If the laptop or PC does not have a serial interface, use the USB adapter

761-9005, which is available as an accessory.

waco'
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7.2.8 Modbus Interface

Table 12: Modbus Interface

( D Pin Description
54 3 2 1
@ @ 1 Not assigned
2 Not assigned
9 8 7 6
3 Not assigned
4 Not assigned
5 GND
6 Not assigned
L PC ) 7 Modbus RX
Figure 9: 8 Modbus TX
PC Interface 9 Not assigned
Table 13: Modbus cable allocation
WAGO TO-PASS Modbus
Pin | Description Pin | Description
5 |GND > 5 |[Modbus GND
7 | Modbus RX > 2 | Modbus RX
8 [Modbus TX > 3  |Modbus TX

WAGO TO-PASS®

Telecontrol Modules M 761-20x
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7.3 Examples of Connection

7.3.1 Digital Inputs

Figure 10: Example of connection for switch at input

7.3.2 Analog Inputs

lif@=1iil

“loMmem | 2~

@s)lilfi@nlill
@n)lilfi@nlill
@s)lilfi@nlill
@n)lilfi@ntill

—

Z+
Al1
|-

Figure 11: Example of connection of transducer at input All

0 WAGO TO-PASS®
WAEU Telecontrol Modules M 761-20x



Assembly 23

7.3.3 Digital Outputs

Figure 12: Example of connection of relay at output DO1

7.3.4  Analog Outputs

/’\ AO1

Figure 13: Example of connection of a display device at output AO1

WAGO TO-PASS® o
Telecontrol Modules M 761-20x wAaGo



24  Assembly

7.3.5 Serial Interface for Modbus and PC

5 4 |3 |2 1
5 4 |3 |2 1 0O 00O0O0
QO @ 0 0 O PC
WAGO TO-PASS ] ECRONO
@ ® 06 0 9 8 7 6
9 (8 |7 6
5 4 |3 |2 1
0O 00O0O0
Modbus

O0O0O0O

9 8 7 6

Figure 14: Example of connection of serial interface for Modbus and PC

WAGO TO-PASS
(Master)
5 4 [3 |2 1
0O0o0O0OO RS232
0o0O0O
9 8 7 6
RS485 T+T- R+ R-Gnd
-
: Modbus ;
T+T- R+ R-Gnd T+T- R+ R-Gnd
Device n L Device m
(Slave) (Slave)

Figure 15: Example of connection of Modbus RS485 Network (fullduplex)

0 WAGO TO-PASS®
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8 Display Elements

Table 14: Display Elements

Com Busy Run .
Description
green green green
Initialization phase,
OCom after start-up, approx. 50 s,
OB On On On check and log on to the GSM
usy
network
ORun
On Off On Communlcatlon via RS232
interface
Off On On Communication via GSM
modem
Status
DS 2 Hz
Figure 16: Display Off Off b]inking Error
Elements
0.5 Hz
Off Off blinking Ready

WAGO TO-PASS®
Telecontrol Modules M 761-20x
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9

Commissioning

NOTE:

Do not switch on yet!
Switch on the TO-PASS® M telecontrol module only after being prompted to
do so; do not insert the SIM card for this procedure.

Deactivate the PIN!

During the commissioning, the SIM card may be disabled when a faulty or
incomplete PIN number is entered.

Therefore it is recommended that you disable the PIN of the SIM card to be
inserted. For this purpose, insert the SIM card in a mobile telephone and
select the menu option Security > Disable PIN.

Deactivate the call diversion
Deactivate all call diversions of the SIM card to be inserted to achieve a
trouble-free availaility of the TO-PASS® M telecontrol module.

As the first step, the TO-PASS™ M telecontrol module must be configured with a
telephone number.

1.

Each TO-PASS® M telecontrol module requires a SIM card for operation,
which may be obtained from any mobile telephone service provider. Special
data cards are recommended.

Each SIM card contains a telephone number and a PIN code, which the SIM
card enables for operation in the 7O-PASS® M telecontrol module. Keep
this telephone number and PIN code at hand.

Connect the PC to the mounted TO-PASS® M telecontrol module via serial
interface.

If the PC has only USB interfaces, a USB — RS-232 adapter is required.
A USB adapter is available as an accessory 761-9005.

Start the PC and then the TO-PASS® operator software.
Select the menu option File > Set.

Set this as a “RS232” connection and select the respective interface, e.g.
“COM1™.

Select the menu option File > New Module.

In the input window enter the identity (max. 8 characters) of the new device.
The identity is the name of the TO-PASS™ M telecontrol module and serves
as an identifier. It can be changed subsequently only after overwriting it.
The identifier is also transmitted in the event of error messages as SMS, fax,
or e-mail and should be an identifier for the location of use, such as
“Tank1”.

waco'
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10.

11.

12.

13.

14.

15.

16.

17.

18.

A new module will be created at the top left of the screen in the project tree.
Click on “+” so the tree expands. Go to “Identity” and enter the telephone
number of the SIM card in the second line at the top right of the screen.
Deactivate the pushbutton [Use PIN] in the following line so that the 70-
PASS® M telecontrol module does not use the PIN Code. Also deactivate the
PIN Code on the SIM Card! For this purpose, insert the SIM card in a
mobile telephone and select the option Disable PIN in the Security menu.

If the PIN Code has to be used, activate the [Use PIN] button in the 70-
PASS® operating software. Also activate the PIN Code of you SIM-Card
using your mobile telephone.

The telephone number should be the data number of the SIM card if it is
available. If using a tariff that does not offer any data transmission options
(which means that no data number is available) then, apart from SMS, e-
mail and fax operation, it is possible to select the TO-PASS™ M telecontrol
module via remote configuration only with the help of a GSM modem.

Switch on the power to the TO-PASS™ M telecontrol module. Shortly
afterward, the “Busy” LED will flash.

Select the menu option Edit > Write Parameters in the operator software.
The operator software now transmits the parameters in the 7O-PASS® M
telecontrol module.

After error-free transmission, switch off the 70-PASS® M telecontrol
module.

Carefully push the SIM Card into the SIM Card slot of your TO-PASS® M
telecontrol module (e.g. using a screw driver) until it locks into position.
The SIM Card is then positioned 2 mm within the enclosure.

The SIM Card is released by pressing it again.

Switch on the TO-PASS® M telecontrol module again and wait until the
initialization phase is complete. The initialization phase ends when the
“Run” LED lights up with brief flashes.

The TO-PASS® M telecontrol module is now ready for use and
configuration. For this purpose, follow the instructions given in the
“Configuration” section.

WAGO TO-PASS®
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10
10.1

Parameter Setting

General Settings

Select the menu point File > Settings, for carrying out general settings, such as
type of connection, interface or language for the TO-PASS" operating interface.

— Connection
& Cable  © GSM = Analog 0 ISDM
Maodem init : I
Fre values : I
— Compart
COM1 =]
— Language
& Englizh " Geman " French
Save Cancel

Figure 17: General settings

Connection

RS232/GSM/ Select the type of connection for communicating with the

Analog / ISDN TO-PASS® M telecontrol module:
RS232 Direct connection via the RS232-Cable,
GSM Access via GSM-modem at the PC,
Analog Access via analog modem at the PC,
ISDN Access via ISDN-modem at the PC.

Comport

COM1 ... COMx Here, select the serial interface where the communication
cable is connected with a RS232 connection.

Language

English / German / Select the language for the TO-PASS"™ operator interface

French here.

Using the button [Save], the settings are taken over and the dialog window is

closed.

Using the button [Cancel], the dialog window is closed without taking over the

settings.

waco'
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10.2 Read Parameters

After you have set the type of connection for communicating with the 7O-PASS™
M telecontrol module, you are then able to read-out the parameters of the
connected module.

For this purpose, select the menu point Controller > Read Parameters. The
software now reads out all the parameters of the T7O-PASS™ M telecontrol module.

Then you can adapt the parameter according to your requirements.

WAGO TO-PASS® o
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10.3

Identity

Select the TO-PASS™ M telecontrol module to be configured from the project tree;
under it, select the Identity option.

On the right side you will find the display field for the name, the input field for
the telephone number, buttons and input fields for the PIN and roaming and the
input field for the alarm counter.

General :

M arme

e |01 23456789

Pln LISE pln | Ixxxxxxxx

Roaming : Allowy | I

Alarm caunter ; [0 = aff: 1..99 alarmz]

Figure 18: Configuring the identity

General

Name The module name is assigned when a new module is set
up and cannot be subsequently changed.

Phone Enter the telephone number of the SIM card inserted into
the module.

Pin If you wish to use the PIN number of the SIM card
inserted, press the [Use pin] button and enter the PIN
number.

Roaming If you want to enable roaming, press the [Enable] button.

Alarm counter

If you want to limit the number of alarms transmitted
each minute (e.g., in case of a damaged cable), then enter
the maximum number of desired alarms here.

waco'
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10,4 Addresses

The TO-PASS® M telecontrol module can communicate with a maximum of four
transmitters/receivers via GSM.

Messages are sent by the TO-PASS™ M telecontrol module as SMS, however, they
can also be sent as an e-mail, fax or voice mail through configuration.

In addition, the TO-PASS™ M telecontrol module can transmit messages to an
Internet address.

Select the TO-PASS®™ M telecontrol module to be configured from the project tree
and the option Addresses.
The input fields for the addresses are on the right side:

Phone/F antail :

Adresz 1 : I 72T
Adress 2 I 121 |
Adresz 3 I 72T I
Adress 4 I 121
Internet :

Host adress ; I

Hoszt part IE":I

Script [V alues] ;

Script [Logger]

Idzer:

ArCcess gerver I
|
|

Pazzwiord ;

Figure 19: Configuring the addresses

WAGO TO-PASS® o
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Phone/Fax/Mail

Address 1
... Address 4

Transmission as SMS:

Simply enter the mobile telephone number of the
receiver.

Press the pushbutton [T2T], when the SMS receiver is
also a TO-PASS" telecontrol module, e.g. when alarm
messages should be used as switching commands in the
other TO-PASS" telecontrol module.

Transmission as e-mail:

First enter the e-mail identifier of the provider of the
WAGO-TO-PASS® SIM card inserted. The following
codes are applicable:

- T-Mobile: 8000

- VODAFONE: 3400

- E-Plus 7676245.

Then a comma (,) follows the end of a code, followed by
the e-mail address, .e.g. “8000,receiver@provider.net” if
using a T-Mobile SIM card.

Transmission as fax:
Enter the code “99” directly preceding the fax number,
e.g.: “99057123456789”.

Internet

Host address

Enter the host address of the corresponding Web server,
e.g. “www.to-pass.com” for testing.

Host port

80

Script (values)

Enter the sript name of the corresponding database, e.g.
“wago/savedataM 15.php” for testing.

Script (logger)

No entry here, if script name has been entered at Script
(values)!

Access server

Enter the name of the access server of the provider of the
SIM card, e.g.:

- T-Mobile: internet.t-mobile

- Vodafone: web.vodafone.de

User

Regardless

Password

Enter the password for the access server, e.g.:
- T-Mobile: T-D1
- Vodafone: d2

waco'
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10.5 Input and Output Configuration

10.5.1 Digital Inputs

Select the TO-PASS® M telecontrol module from the project tree on the left using
the identity. Select the input to be configured under the entry Digital input.

The parameters of the input are given on the right side.

The input fields are identical for all digital inputs:

Alarm settings

Set text ; IDIN1 oh

betess: 2l 2] 3] 4] meme |
Analog value : LI _EI _3J _4| _5J _EI _?J _EI

Reset text : IDlN-I off

Adress : LI _2| _3| _4| Internet |
AnalogValue : LI _2| _3| _4| _5| _EI _?J _EI

Figure 20: Configuring the digital inputs

Alarm settings

Set Text Message text of the transmitted message when the digital
input is set.
Address Selection of where the message should be transmitted if

the digital input is set. One or all addresses can be
selected independently. Press the [Internet] button for
applications having cyclic GPRS transmission.

Analog value

Up to four analog values can be clicked here, which
should be transmitted in addition to the fault message.

Reset Text Message text of the transmitted message when the digital
input is reset.
Address Selection of where the message should be transmitted if

the digital input is reset. One or all addresses can be
selected independently. Press the [Internet] button for
applications having cyclic GPRS transmission.

Analog value

Up to four analog values can be clicked here, which
should be transmitted in addition to the fault message.

WAGO TO-PASS®
Telecontrol Modules M 761-20x
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10.5.2 Multiplex Input

The digital inputs DI1 ... DI4 can be configured as multiplex inputs. In such a
case, these four inputs are read in as a combination and interpreted as a binary
number. The following applies in this case:

DI1=2"=1
DIR2=2'=2
DI3 =2*=4
DI4=2°=38

Thus, for example, if DI1 and DI3 are set, then the binary number is 5. If only DI4
is set, then the binary number is 8.

An alarm text can be defined for each of the 16 states (0 ... 15). The recipients of
the alarm text message are selected with the help of the multiplex settings.

10.5.2.1 Multiplex Settings

Select the TO-PASS™ M telecontrol module from the project tree on the left using
the identity. Select the Multiplex Settings option under the Multiplex Input
entry. The buttons for enabling multiplex operation and the selection of the
recipients of the analog values to be transmitted are provided on the right side.

U zing/Adress

tultiplex mode ; Usze |

Adrezs LI _2| _3| _4| Irikernet |
Analog value LI _EI _3J _4| _5J _EI _?J _EI

Figure 21: Configuring the multiplex settings

Using/Address

Multiplex Mode Press the button [Use] to enable or disable multiplex
operation for the inputs DI1 ... DI4.

Address Selection of where the message should be transmitted if
the multiplex input has been set. One or more, or all
addresses can be selected independently. Press the
[Internet] button for applications having cyclic GPRS
transmission.

Analog Values Up to four analog values can be clicked here, which
should be transmitted in addition to the multiplex
message.

0 WAGO TO-PASS®
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10.5.2.2 Multiplex Alarm Texts

Select the TO-PASS"™ M telecontrol module from the project tree on the left using
the identity. Select the Multiplex Table option under the Multiplex Input entry.
The input fields for the alarm texts pertaining to the 16 states are provided on the
right side.

Alarm ket

Walue 0
VYalue 1 :
Yalue 2
Walue 3 :
Yalue 4
Walue 5
Yalue E
Yalue ¥
Walue 8 :
WYalue 9:
Yalue 10
Walue 11 :
Yalue 12
Walue 13
Yalue 14
Yalue 15:

Figure 22: Configuring the multiplex alarm texts

Alarm Text

Value 0 Enter the various alarm texts to be transmitted for each of
the states pertaining to the digital inputs.

Value 15

WAGO TO-PASS® o
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10.5.3

Analog Inputs

Select the TO-PASS™ M telecontrol module from the project tree on the left using
the identity. Select the input to be configured under the entry Analog input.

The parameters of the input are given on the right side.

The input fields are identical for all analog inputs:

Morm zettings

Input range ; I .20 mé 4,20 md |

Wi el o [9393 . 9939]

Max valus: [100 [9399 . 9339]

T IZ

Alarm settings ;

First walue : I?E I Hze fall I
First test ; I'ﬁlN-I mas

Adress LI _2| _3| _4| Internet |

Analog value ; ﬂ _El ﬂ _4| ﬁ _El ﬂ _El

Second value ;
Secand text :
Adress

Analog value :

{25 e |[[

[£IN1 min

] 2l 3] ] inemet |
Al 2] 3 4] 5] 8] 7] 8]

Figure 23: Configuring the analog inputs

Norm settings

Input range

Select the input signal for the sensor connected to the
TO-PASS® M telecontrol module.

Min. value

Starting value, from which the given value is normalized.
This value corresponds to the minimum input current
value of 4 mA or 0 mA.

Max. value

End value, up to which the given value is normalized.
This value corresponds to the maximum input current
20 mA.

Unit

Enter the unit here with a maximum of 5 characters with
which the normalized process value should be
transmitted.

waco'
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Alarm settings

First value

First limit value, from which an alarm indication is
triggered. Select whether the alarm indication should be
triggered with overshoot or undershoot of the limit value.

First text Alarm message that is triggered with overshoot or
undershoot of the limit value.
Address Selection of where the message should be transmitted.

One or all addresses can be selected independently. Press
the [Internet] button for applications having cyclic
GPRS transmission.

Analog value

Up to four analog values can be clicked here, which
should be transmitted in addition to the alarm message.

Second value

Second limit value, from which an alarm indication is
triggered. Select whether the alarm indication should be
triggered with overshoot or undershoot of the limit value.

Second text

Alarm message that is triggered with overshoot or
undershoot of the limit value.

Address

Selection of where the message should be transmitted.
One or all addresses can be selected independently. Press
the [Internet] button for applications having cyclic
GPRS transmission.

Analog value

Up to four analog values can be clicked here, which
should be transmitted in addition to the alarm message.

WAGO TO-PASS®
Telecontrol Modules M 761-20x
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10.5.4

Digital Outputs

Select the TO-PASS™ M telecontrol module from the project tree on the left using
the identity. Select the output to be configured under the entry Digital output.
The parameters of the output are given on the right side.

The input fields are identical for all digital outputs:

Remote sethings

Set bext

Reset text :

Reszet time ;

{DOUT1=1

|DouT1=0

[0 = off: 1..99 seconds]

Figure 24: Configuring the digital outputs

Settings

Set text If the TO-PASS™ M telecontrol module receives this text
as an SMS, it switches this digital output on and connects
the DC voltage available at terminal 37 to the
corresponding digital output.

Reset text If the TO-PASS® M telecontrol module receives this text
as an SMS, it switches this digital output off and
disconnects the DC voltage available at terminal 37.

Reset time If the digital output is switched on, it will remain on for

this time period and thus connected to terminal 37. After
the reset time expires, the digital output switches off
voltage from terminal 37. The “0” value disables this
function; i.e., the output remains active indefinitely after
being switched on.

waco'
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10.5.5 Analog Outputs

Select the TO-PASS™ M telecontrol module from the project tree on the left using
the identity. Select the output to be configured under the entry Analog output.
The parameters of the output are given on the right side.

The input fields are identical for all analog outputs:

Morm zettings

Output range : I

0. 20 mé, 4,20 md,

Min. value : ID

b aw. value I-I a0

T I

i

Bemote sethings :

Set bext A0UTT=

Figure 25: Configuring the analog outputs

Norm settings

Output range Select the output signal for the device connected as either
0...20mA or4...20 mA.

Min. value This value normalizes the starting value, which
corresponds to 0 mA or 4 mA for this output.

Max. value This value normalizes the end value, which corresponds
to 20 mA for this output.

Unit Corresponding unit for the minimum and maximum
value.

Set the output

Set text If this text is transmitted with a value that lies between
the minimum and maximum value, then the T 0-PASS® M
telecontrol module sets the analog output to this value.

WAGO TO-PASS®
Telecontrol Modules M 761-20x
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10.6 Configure Fault Indicator

The TO-PASS® M telecontrol module can transmit fault messages to maximum
four receivers. The receivers are informed either directly one after another or (if
configured) after expiration of the time delay for acknowledgment. The message
is sent by the TO-PASS™ M telecontrol module as an SMS; however, it can also be
sent as an e-mail, fax or voice mail via configuration.

10.6.1 Alarm messages from Digital Inputs

If on or off states of digital inputs are to be sent as fault messages, then select the
desired receiver for the respective states of the inputs with the help of the buttons
[1] ...[4]. In addition, it is possible to specify the analog values that are
transmitted along with the fault message.

10.6.2 Limit Value Messages of Analog Inputs

It is possible to specify a maximum of 2 limit values for every analog input for
which limit value violations (overshoot or undershoot) should be sent as fault
messages.

Enter the desired value and select whether the fault message should be sent for
overshoot or undershoot of the limit value using the buttons [rise] or [fall].
Select the desired receiver for the respective limit value using the buttons [1] ...
[4]. In addition, it is possible to specify the analog values that are transmitted
along with the fault message.

0 WAGO TO-PASS®
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10.6.3 Acknowledgement

Acknowledgment is the confirmation that a message has actually been sent to the
receiver. Select the TO-PASS™ M telecontrol module from the project tree using
the identifier. Select the entry Quit function under the option Special functions.
The right side contains the input fields for the waiting time and the number of

repetitions.
Settings
Wit time IEI [0..99 minutez]
Fepeat cycles ; ID [0..99 tirmes]

Figure 26: Configuring the acknowledgment response

Settings

Wait time The TO-PASS® M telecontrol module waits briefly to be
entered here and acknowledgment after it has transmitted
an alarm message. The acknowledgment takes place with
the help of a simple call by the receiver to the TO-PASS"™
M telecontrol module.

The TO-PASS® M telecontrol module accepts the call and
disconnects it automatically. An acknowledgment SMS
with the identifier and the text “QUIT” is sent.

Repeat cycles Set the cycle time here for checking for the
acknowledgment. If no receiver acknowledges the
message of the TO-PASS® M telecontrol module, then the
entire cycle can be executed again, allowing the 70-
PASS® M telecontrol module to inform the first address
once again and wait for an acknowledgment.

WAGO TO-PASS® o
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10.7 Transmission Refresh Times

Select the TO-PASS®™ M telecontrol module from the project tree using the
identifier. Select the entry Refresh times under the option Special functions.
The input fields for the web interval and the SMS interval are located on the right

side.
S ettings
wieh cycle tinme : IEI [0..9993 minutes / to web zerver)
S5 cycle time ID [0..9939 minutez / to first adress]

Figure 27: Configuring the transmission repeat times

Settings

WEB cycle time Enter the cycle time here in minutes, which are intervals
that the TO-PASS®™ M telecontrol module should transmit
to the Internet.

If “0” is entered, the transmission is disabled.

It is possible to enter a maximum value of 9999 minutes,
which corresponds to approximately one transmission per
week. The cycle time set determines the transmission
costs.

One transmission corresponds to approx. 1 kB.

If setting a cycle time of 60 minutes (one transmission
per hour) then the data volume generated per month is 1
kB * 24 hours * 30 days = 720 kB per month.

A SIM card with an inclusive volume of 1 MB per month
would suffice for this cycle time.

SMS cycle time Enter the cycle time here in minutes at which the 70-
PASS® M telecontrol module should transmit to the first
receiver address configured.

The SMS contains the status of the digital inputs, the
values and units of the analog inputs, the status of the
digital outputs and the values and units of the analog
outputs.

The cyclic SMS can, for example, be used for operational
supervision.

0 WAGO TO-PASS®
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10.8 Time Control

Select the TO-PASS®™ M telecontrol module from the project tree using the
identifier. Selet the entry Time control under the option Special functions.
The buttons for various settings pertaining to time adjustment are located on the
right side.

S ettings

Time zet SMS Internet DICF

Figure 28: Setting the time adjustment

Settings

Time set If the [SMS] button is pressed, then the T 0-PASS® M
telecontrol module sends an SMS to itself and receives
the current time from the time transmitted by this SMS.
The time adjustment using an SMS takes place only once
when the TO-PASS™ M telecontrol module is restarted.
This type of time adjustment using SMS transmission has
an inaccuracy of approximately 10 seconds.

If the [Internet] button is pressed, then the TO-PASS® M
telecontrol module receives the time from the Internet
server with every cyclic transmission to the Internet. This
type of time adjustment using transmission to the Internet
server has an inaccuracy of approximately 3 seconds.
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10.9

10.9.1

Modbus

The Modbus functionality facilitates connectivity for Modbus interface-equipped
devices. The devices must be configured as slave devices and are connected via
PC interface. As a result, the TO-PASS™ M telecontrol module operates as a
master.

Communication takes place via pins 7 (Tx), 8 (Rx) and 5 (GND).

A maximum of up to 64 registers can be transmitted.

An RS-232/RS-485 interface converter is required if several Modbus devices are
to be connected to the TO-PASS® M telecontrol module within an RS-485
network.

Modbus Settings

Select the TO-PASS™ M telecontrol module from the project tree using the
identifier. Select the option Modbus Settings under the Modbus entry. The
buttons for the Modbus format and the input field for the polling cycle time are
provided on the right side:

I zing/Format

todbus format ; I':":': not used j

Scan rate I-“:I # 10 mz

Figure 29: Configuring the Modbus settings

Using/Format

Modbus format Select the transmission format for the Modbus
communication; the format selected must be compatible
with the controller used.

The following formats are possible:

00 |Notused (No Modbus connection)

01 |RTU, 9600, 8, N, 2

02 |RTU, 9600, 8, E, 1

03 |RTU, 9600, 8, O, 1

Scan rate Enter the Modbus subscriber cycle time as an integral
multiple of 10 ms.

waco'
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10.9.2 Modbus Alarm

When using the Modbus functionality, a discrete input can be defined that triggers
an alarm when it assumes the high state (logical “17).

Select the TO-PASS™ M telecontrol module from the project tree using the
identifier. Select the option Modbus Alarm under the Modbus entry.
The input fields and buttons for the alarm settings are provided on the right side.

Alarm settingz [Dizcrete input)

Device/Reqizter : IEI ID

Alarm et - IM-::dI:-us-.-’-‘-.Iarm

Adrezs LI _2| _3| _4| Internet

Figure 30: Configuring the Modbus alarm

Alarm Settings (Discrete Input)

Module/Register

Alarm text This is the alarm message that is displayed when the
selected Modbus input enters the high state.

Address Selection of where the message should be transmitted if

the Modbus input is set. One or more, or all addresses can
be selected independently. Press the [Internet] button for
applications having cyclic GPRS transmission.

WAGO TO-PASS® o
Telecontrol Modules M 761-20x wWAGD



46  Parameter Setting

10.9.3 Modbus Registers

A maximum of 64 registers can be read from the Modbus subscribers connected.
The registers are divided in four groups (1 ... 16, 17 ... 32,33 ... 48, 49 ... 64).

Select the TO-PASS™ M telecontrol module from the project tree using the
identifier. Select the option Modbus Registers for the corresponding group under
the Modbus entry.

The input fields for the addresses of the registers to be polled are provided on the
right side. The input fields are identical for all register groups:

Walue table: Device/Reaqizter/MN.ame [Input regizter]

[0 [0 |
[0 [0 |
[0 [0 |
[0 [0 |
[0 [0 |
Io [0 |
[0 [0 |
[0 [0 |
[0 [0 |
[0 [0 |
[0 [0 |
[0 [0 |
[0 [0 |
Io [0 |
[0 [0 |
[0 [0 |

Figure 31: Configuring the Modbus registers

Value table: Device/Register/Name (Input register)

Registers 1 ... 16, Enter the address of the Modbus subscriber under the
(Registers 17 ... 32, column Device and the number of the register to be
Registers 33 ... 48, polled under the column Register. Enter a name under

Registers 49 ... 64) the column Name.
Each value is read in as a 16-bit value and; a maximum of
64 values can be read.
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10.10 Data Memory

Select the TO-PASS®™ M telecontrol module from the project tree using the
identifier. Selet the entry Data logger under the option Special functions. The
input field for the cycle time and a button for calculating the average value are
located on the right side.

S ettings

Cycle time : I-I [1..99 minutez]

Average values ; Use

Figure 32: Configuring the data memory

Settings

Cycle time Enter the cycle time in minutes at which the process
image should be saved. The process image contains all
digital and analog output values. The data memory is a
cyclic buffer with a capacity of 4200 process images, i.e.
when the buffer is full, the oldest process images are
overwritten (FIFO).

Average values Press the [Use] button in order to switch the average
value calculation on or off.
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10.11 Write Parameters

After you have adapted all parameters to your requirements, you have to write
these parameters to the module connected.

For this purpose, select the menu point Controller > Write Parameters. The
software now writes all the parameters into the TO-PASS™ M telecontrol module.

Then the TO-PASS® M telecontrol module is ready for operation.

0 WAGO TO-PASS®
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11 Handling

111 Remote Query of Process Values

The TO-PASS™ M telecontrol module offers two options for remote query of the
process values available.

. query via SMS
. query with the TO-PASS® operator program.

11.1.1  Query via SMS

For query via SMS, please send an SMS with the text “State” to the 7O-PASS® M
telecontrol module. The TO-PASS® M telecontrol module responds promptly with
an SMS containing all digital and analog process values to a mobile telephone.

Table 15: SMS installation

Value transmitted Description

Module 1 Identity

10010011 Condition of the digital inputs 1 ... 8
(0 =not set, 1 = set)

+00000 mA Analog input 1

+00000 mA Analog input 2

+00000 mA Analog input 3

+00000 mA Analog input 4

+00000 mA Analog input 5

+00000 mA Analog input 6

+00000 mA Analog input 7

+00000 mA Analog input 8

0110 Condition of the digital outputs 1 ... 4
(0 =not set, 1 = set)

+00000 mA Analog output 1

+00000 mA Analog output 2

AC=99 Alarm counter
(displays the alarms that are still possible per hour)

From:+0123456789 | Telephone number of the TO-PASS™ M telecontrol
module

hh:mm dd-mm-yy Time and date of the SMS
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11.1.2

Query with the TO-PASS® Operator Program

For a process values query with the TO-PASS® operator program, please select the
menu option Visual > I/O values. The program establishes a link to the 70-
PASS® M telecontrol module selected. Please note the mode of accessing the TO-
PASS® M telecontrol module, either via direct RS-232 cable connection or an
analog ISDN or GSM modem dial-up. The selection is specified in the menu
option File > Set.

. TO-PASS - Visual 170 values H=l &3
[ [ Modkus | [ rilne
- Digital input
Input 1 : Input 2 Input 3 Input 4 Input 5 Input B Input 7 Input &
—Analog input
Input 1 : Input 2 : Input 3 : Input 4 : Input 5 : Input B : Input 7 Input & :
04100 % 0400 % 04100 2 04100 % 04100 % 04100 2 04100 % 04100 %
P P P P P g P p
Ewuz Emuz Ewuz Ewnz Emuz Ewuz Emnz Emuz
a i] a a a a a a
- Digital output
Output 1 : Output 2 Output 3 : Output 4 :
Set/Reset I Set/Reset | Set/Reset | Set/Reseat I
—Analog output
Output 1 Output 2
04100 % 0100 %
D |0
Set I Set |

Figure 33: Visualization of the process values

Press the [1/0] button to display the process values of the digital and analog
inputs and outputs. The process values displayed are valid if the on-line display is
green.

Process values pertaining to digital and analog inputs are displayed in the upper
portion of the window and those pertaining to digital and analog outputs are
displayed in the lower portion of the window.
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11.2 Telecontrol

TO-PASS® M telecontrol modules offer the option of influencing a process
remotely with the help of their analog and digital outputs. There are two methods
available:

. telecontrol via SMS
. telecontrol with the TO-PASS® operator program.

11.21 Telecontrol via SMS

To set or reset a digital output, please send an SMS with the text that is entered
under Set text and/or Reset text for this output to the 7O-PASS™ M telecontrol
module.

The TO-PASS®™ M telecontrol module acknowledges the command with an SMS
containing the identifier, the text sent and the current reading of the alarm counter.

Example:

Table 16: Example of parameter for Set DO

Parameter Setting
Set DOUTI=1
Reset DOUTI1=0
Reset time 0

Send an SMS with the text “DOUT1=1" to the TO-PASS™ M telecontrol module
in order to switch on the output 1.

The TO-PASS® M telecontrol module acknowledges the command with an SMS
with the identifier, the text “DOUT1=1 OK!”.

Send an SMS with the text “DOUT1=0" to the TO-PASS™ M telecontrol module
in order to switch off the output 1.

The TO-PASS® M telecontrol module acknowledges the command with an SMS
containing the identifier, the text “DOUT1=0 OK!”.
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In order to set an analog output, send an SMS with the text, which is entered
under Set text, and the value to be set to the TO-PASS® M telecontrol module.
The TO-PASS® M telecontrol module acknowledges the command with an SMS
containing the identifier, the text sent, the value set and the current reading of the
alarm counter.

Example:

Table 17: Example of parameter to set AO1

Parameter Setting
Output range: 0..20mA
Min. value: 0

Max. value: 100

Unit: %

Set text: AOUTI=

Send an SMS with the text “AOUT1=75" in order to set the analog output 1 to a
value of 15 mA =75 %.

The TO-PASS® M telecontrol module acknowledges the command with an SMS
containing the identifier, the text “AOUT1=+00075% OK!” and the current
reading of the alarm counter.

waco'
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11.2.2

Telecontrol with the TO-PASS® Operator Program

For a process values query with the TO-PASS® operator program, please select the
menu option Visual > I/O values. The program establishes a link to the 70-
PASS® M telecontrol module selected. Please note the mode of accessing the TO-
PASS® M telecontrol module, either via direct RS-232 cable connection or an
analog ISDN or GSM modem dial-up. The selection is specified in the menu
option File > Set.

. TO-PASS - Visual 170 values H=l &3
[ [ Modkus | [ rilne
- Digital input
Input 1 : Input 2 Input 3 Input 4 Input 5 Input B Input 7 Input &
—Analog input
Input 1 : Input 2 : Input 3 : Input 4 : Input 5 : Input B : Input 7 Input & :
04100 % 0400 % 04100 2 04100 % 04100 % 04100 2 04100 % 04100 %
P P P P P g P p
Ewuz Emuz Ewuz Ewnz Emuz Ewuz Emnz Emuz
a i] a a a a a a
- Digital output
Output 1 : Output 2 Output 3 : Output 4 :
Set/Reset I Set/Reset | Set/Reset | Set/Reseat I
—Analog output
Output 1 Output 2
04100 % 0100 %
D |0
Set I Set |

Figure 34: Visualization of the process values

Press the [1/0] button to display the process values of the digital and analog
inputs and outputs. The process values displayed are valid if the on-line display is
green.

Process values pertaining to digital and analog inputs are displayed in the upper
portion of the window and those pertaining to digital and analog outputs are
displayed in the lower portion of the window.

You can set or reset the digital outputs by pressing the buttons [Set/Reset] or you
can change the analog outputs by entering set-point values and finally pressing the
[Set] button.
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11.3

Acknowledge Fault Messages

If a waiting time not equal to 0 has been set for the acknowledgment of fault
messages, then the TO-PASS™ M telecontrol module expects an acknowledgment
of fault messages from the receiver.

The acknowledgment occurs via a simple call to the TO-PASS® M telecontrol
module.

Select the TO-PASS™ M telecontrol module and the connection is established after
2 or 3 ring signals. Finally, the connection to the TO-PASS™ M telecontrol module
is interrupted. The fault message is thus acknowledged. In addition, the 70-
PASS® M telecontrol module sends an SMS with the text “Quit”.

NOTE: Waiting time

When the TO-PASS® M telecontrol module waits for an acknowledgment it
is inactive for other tasks. Both the “Run” and “Busy”” LEDs also light up.
During the waiting time no messages are sent and no commands are
accepted.

If the message in not acknowledged within the waiting time set, then the 70O-
PASS® M telecontrol module sends the fault message automatically to the next
receiver entered under addresses and waits again for the defined waiting time for
an acknowledgment.

If none of the receivers defined acknowledge the fault message and the number of
repetitions is not set to 0, then the procedure is repeated until one receiver
acknowledges the fault message or the maximum number of repetitions has been
reached.
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11.4  Switching Standby

NOTE: Standby authorization

Switching the ready state on and off is only possible by subscribers whose
telephone number has been entered in the address list!

Using the “Standby” function, it is optional to change all messages sent by the
TO-PASS"™ M telecontrol module specifically to the respective standby state. This
takes place with simple changeover via SMS.

To do this, send an SMS with the text “Standby1” to the TO-PASS™ M telecontrol
module. The TO-PASS™ M telecontrol module then transmits all alarm messages
to the SMS sender. Other receivers defined in the TO-PASS® M telecontrol
module are no longer informed.

In order to switch this function off send an SMS with the text “Standby0” to the
TO-PASS® M telecontrol module.
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11.5

Display Data Memory (DSP)

The TO-PASS® M telecontrol module has a data memory that can store up to 4200
process images as a special function. A process image corresponds to all digital
and analog values available at the TO-PASS™ M telecontrol module. The cycle
time with which the process image should be saved is configurable. At the same
time, the average value can be specified for cyclic storage.

To read the contents of the data memory, select the menu option Controller >
Read all logger records. Then display all values of the data memory with the
help of the menu option Visual > Data logger.

Either select all inputs or only specific inputs with the help of the selection field in
the upper portion of the window.

All inputs are displayed in the form of a table with the date and time, the states of
the digital inputs and the values of the analog inputs.

Individual digital inputs are displayed as a bar chart and individual analog values
are displayed as trend curves.

Above the table or the diagram the date and time of the first value displayed is
shown on the left side, and, on the right side, the date and time of the last value
displayed.

The navigation buttons on the right side of the window have the following
meaning:

Table 18: Navigation DSP

Button Function
Jumps to the first data record of the table or the diagram

Jumps to the previous data record

Goes back by 20 data records

Goes forward by 20 data records

Jumps to the next data record

Jumps to the last data record of the table or the diagram

Pages the table or the diagram back to the first data record

Stops paging in the table or the diagram

Pages the table or the diagram forward to the last data record
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WAGO TO-PASS®
Telecontrol Modules M 761-20x




Handling 57

11.6  Display Event Memory (ESP)

In contrast to the data memory, the event memory saves the complete process
image of the TO-PASS® M telecontrol module only when an event occurs. This
can be the setting of a digital input or even the violation of a limit value. All
digital and analog values available at the TO-PASS™ M telecontrol module are
saved.

To read the contents of the event memory, select the menu option Controller >
Read all logger records. It is possible to display all values of the event memory
with the help of the menu option Visualization > Event logger.

Either select groups of events or only specific events with the help of the selection
field in the upper portion of the window.

The events are displayed in a list with the date, time and the event text.

The navigation buttons on the right side of the window have the following
meaning:

Table 19: Navigation ESP

Button Function
Jumps to the first data record of the list

Jumps to the previous data record

Goes back by 20 data records

Goes forward by 20 data records

Jumps to the next data record

Jumps to the last data record of the list

Pages the list back to the first data record

Stops paging in the list

Pages the list forward to the last data record
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Diagnostics

12
12.1

Diagnostics

Test Inputs and Outputs

To test the inputs and outputs select the menu option Controller > Test I/O. The
following window is displayed:

Test controller

— Digital input
I N N D D D .
1| 2| : | + | 5| e | 7| s |
— Analog input
Channel 1: Channel 2: Channel 3: Channel 4: Channel 5: Channel B: Channel ¥: Chatnel 8:
oo 000 oo 000 oo | 000 oo | 000
— Digital output
I N I
i N [ [
— Analog output
Channel 1: Channel 2:
I mé, I mé,
Set Set

Figure 35: Test inputs and outputs

The states of the digital and analog inputs are displayed in the upper region. By
pressing the buttons [1] ... [4] in the upper region switch digital inputs on and off
and by entering numerical values and finally pressing the [Set] button the analog

outputs can be set.

Press the [Exit] button to end the test and close the window.

Alternatively, the inputs and outputs can also be tested with the help of the menu
option Visual > I/O values.

waco'

WAGO TO-PASS®
Telecontrol Modules M 761-20x



Diagnostics 59

12.2

12.3

Test the Connection

To test the connection, select the menu option Controller > Test SMS/GPRS.
The following window is displayed:

CEGE |
Adress IT _2| _3| _4| Internet |

IInstructered sting [gzent with data) ;

Send |

E st |

Figure 36: Test the connection

Select the address to send an SMS and enter the text to be sent. Press the [Send]
button to send the message. The status of the transmission is finally displayed.

Press the [Exit] button to end the test and close the window.

Test the Modem

To test the link, select the menu option Modem > Test. The following window is
displayed:

Tostmoden

Initialization ; I

Met : I

Signal ; llllllllll I 0

Figure 37: Modem test
Connection is established and the signal strength is displayed.

Press the [Exit] button to end the test and close the window.
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13

13.1

WAGO TO-PASS® Web

GPRS data records V1.50

Set Parameters

Select the TO-PASS®™ M telecontrol module to be configured from the project tree.
Select the option Addresses to enter the parameters for transferring data to a web
server.

You can use the WAGO server to test your application. For this purpose, please
enter the values shown in table in chapter 10.4.

Select the entry Refresh times under the option Special functions and set the
WEB cycle time of the cyclic transmission to the server, e.g. 5 minutes.

The communication as SMS or to the server can be tested under the menu option
Controller > Test SMS/GPRS. Press the [Internet] button and enter any text,
such as, e.g. “TEXT” in the field Unstructured Text. Then press the [Send]
button. The reply "Web Refresh = 0" should follow after approx. 20 seconds.

Now go to the Web address www.to-pass.com and press the [MyTO-PASS]
button.

Enter the user name as “test” and also the password as “test” and press the
[Login] button.

Select your TO-PASS® M telecontrol module from the list and press the [Display]
button.

waco'
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13.2 Web Refresh
The HTTP method “POST” transmits the process image of the WAGO TO-PASS®
telecontrol module to the Internet. A data record consists of from data in the
context of the request.
All data are transmitted as strings (ASCII characters) having a fixed length.
13.2.1 Data Format
Table 20: Data format Web Refresh
Index | Variable | List of contents Format
0 IS Identity Identity[8];Serial number[5]
1 PA Parameter Cycle time[4];Provider[5];Alarm Counter[2]
2 TI Date, Time YY/MM/DD,hh:mm:ss
3 D1 Digital input 1 Value;Alarm
4 D2 Digital input 2 Value;Alarm
5 D3 Digital input 3 Value;Alarm
6 D4 Digital input 4 Value;Alarm
7 D5 Digital input 5 Value;Alarm
8 D6 Digital input 6 Value;Alarm
9 D7 Digital input 7 Value;Alarm
10 D8 Digital input 8 Value;Alarm
11 Al Analog input 1 Value[6];Unit[5];Alarm
12 A2 Analog input 2 Value[6];Unit[5];Alarm
13 A3 Analog input 3 Value[6];Unit[5];Alarm
14 A4 Analog input 4 Value[6];Unit[5];Alarm
15 A5 Analog input 5 Value[6];Unit[5];Alarm
16 A6 Analog input 6 Value[6];Unit[5];Alarm
17 A7 Analog input 7 Value[6];Unit[5];Alarm
18 A8 Analog input 8 Value[6];Unit[5];Alarm
19* US Sub-structured string Data[40]
20** | EMPL Modbus-Alarm Value[2];Status[2];Alarm
21%% | MV Modbus variables 64 x Value[4];
* The variable is sent only if a Web refresh occurs via serial interface.
** The variables are sent only if Modbus is switched on.
NOTE: Alarm flags with multiplex function

If the multiplex function is used then all alarm flags from D1 to D4 are ‘1’
for a multiplex alarm.
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WAGO TO-PASS® Web

13.2.2

13.2.3

Response
The response to the request contains a string and optionally the time of the server.
The server time adjusts the time of the WAGO TO-PASS® telecontrol module.

The response string must be located within the first 250 characters of the HTML
page (incl. HTTP header).

“Values stored”

Date and time are optional and are required only if the time of the WAGO TO-
PASS" telecontrol module is to be set via server.

“Values stored:YY/MM/DD,hh:mm:ss”

The server can also report that the data was not accepted if, for example, a
WAGO TO-PASS" telecontrol module is connected and the operator has made an
incorrect input.

“Values not stored”

Example (Request)

ID=TopasM01;12345
PA=0060;26201;99
D 1,
TI=05/12/02,14:27:59 0
D1=0;0

D2=1;0

D3=1;1

D4=0;0

D5=0;0

D6=0;0

D7=0;0

D8=0;0

Al= 0.123;bar ;O
A2= 25.40;degree ;0
A3= 71.50;degree ;0

([ Cycle time= 60 min, registered at T-

another 99 alarms are possible)

(this value has triggered an alarm)

Ad4= 0.000;mA ;0
AS5= 0.000;mA ;0
A6=-0.000;mA ;0
A7=-0.000;mA ;0
A8=-0.000;mA ;0
US=Hello vyou there !

MA=00;00;0
Mv=0000;0001;0002;0003; 0063
Example (Response):

Values stored:05/12/02,14:28:05
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13.3 WeblLog

In addition to Web Refresh the data records of the data and event loggers can also
be sent to a script of the server. One packet contains 10 compressed data records
of 14 bytes each.

13.3.1 Data format

Table 21: Data format WebLog

Index | Variable | List of contents Format

0 IS Identity Identity[8];Serial number[5]

1 PA Parameter Cycle time[4];Provider[5];Alarm Counter[2]
2 TI Date, Time YY/MM/DD,hh:mm:ss

3 LO Data sets of teh Logger Log[140]

13.3.2 Data Format of a Data Record
Byte: 0 1 2 3 4 5 [
Bit: 76543210765432107654321076543210765432107654321076543210

Inh.: PNNNNNNNSJJJJJIJMMMMDDDDDhhhhhmmmmmmssssssDIN..... AIN1....

Byte: 7 8 9 10 11 12 13
Bit: 76543210765432107654321076543210765432107654321076543210

Inh.: AIN2....AIN3....AIN4....AIN5....AIN6....AIN7....AINS....

P: Pointer for the next data set to be saved
NNNNNNN: Event number

S: Data records already sent

YYYY: Year

DDDDD: Day

MMMM : Month

hhhhh: Hour

mmmmmm : Minute

Ssssss: Second

DIN.....: Digital inputs

AINX....: Analog input channel x (x = 1 ... 8)
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13.3.3 Use

The reception must be acknowledged with “Values stored” (refer to Web
Refresh).

The data records must be decompressed on the server.
The data records with the bits set P=1 or S=I are invalid and must be deleted.

The data records on the server must be sorted with respect to date/time.

0 WAGO TO-PASS®
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14 Disclaimer

TO-PASS" Telecontrol Modules communicate using the GSM network (Global
System for Mobile Communication). Exemptions cannot be made for GSM
services used by the TO-PASS®™ telecontrol modules as they may be exposed to
faults in the service provider’s network. WAGO Kontakttechnik GmbH & Co.
KG has no involvment with these types of problems.

Therefore, WAGO Kontakttechnik GmbH & Co. KG will reject any guarantee for
the implementation of commands transmitted from and received by the TO-PASS"®
telecontrol module.
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Technical Data

Table 22: Technical data Inputs

Number of inputs

Digital 4 (5V ... 24 V)
Analog 8 (0/4 mA ... 20 mA)

Input voltage digital inputs (24 V) nax.

1.6 mA

Interior resistance analog inputs

250 Q

Table 23: Technical data Outputs

No. of outputs

Digital: 4 contacts
Analog: 2 (0/4 mA ... 20 mA)

Load of digital outputs

AC/DC 60 V/1 A

Table 24: Technical data General

Number of recipients

4 (PC, SMS, e-mail, phone, fax)

Communication

GSM Quadband

Communication types

SMS (bidirectional),
DFU selection connection (CSD),
GPRS connection to Internet

Operating voltage DC8V..36V
Closed current 40 mA

Current during transmission <600 mA
Type of mounting TS 32 DIN rail

Wire connection

Spring type connection

Dimensions (W x H x D) 109 mm x 105 mm x 78 mm
Weight approx. 426 G

Operating temperature -20 °C ... +70°C

Storage temperature -20 °C ... +70°C

Degree of protection 1P20

EMC 1 Immunity to interference

in acc. with EN 61000-4-6 (2001)
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